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Part I. Student instructions

Learning goals, objectives, and key concepts
• To understand how phylogenetic trees are constructed and interpreted in

evolutionary studies.
• To gain experience scoring behavioral characters and mapping them onto a

phylogenetic tree.
• To learn how to infer evolutionary histories of behavior using phylogenetic

comparative methods.

Background
Evolution is the underlying principle of biology and, starting with Darwin, animal
behavior rested on a firm foundation of evolutionary principles (e.g., Chapin, 1917;
Friedmann, 1929; Wheeler, 1919; Whitman, 1899). For some anatomical traits, evolu-
tionary history can be followed in the fossil record, especially when a relatively com-
plete fossil series of species is available. Unfortunately, behavior does not fossilize, so
until time travel becomes a reality or the behavior of extinct animals can be studied
using the methods described in the Jurassic Park movies, evolutionary studies of
behavior must rely on comparative methods, by which ancestral states and the
pattern of evolutionary changes in behavior can be inferred (Martins, 1996). Compar-
ative studies of behavior gained considerable momentum in the 1940 and 1950s as
influential ethologists such as Konrad Lorenz and Niko Tinbergen championed the
view that behavior could be used to infer evolutionary relationships (phylogeny)
among species and that behavior must evolve in a phylogenetic context. For example,
in his study of the evolution of courtship displays of “dabbling” ducks (those that feed
from the surface), Lorenz (1958) said, “every time a biologist seeks to know why an
organism looks and acts as it does, he must resort to the comparative method.” Tinber-
gen (1963) included evolution as one of the now famous four areas of animal behavior,
and he described the comparative method as follows:

Throughcomparison [thenaturalist] noticesboth similarities between speciesanddif-
ferences between them.Eitherof these canbe due to one of two sources.Similarity can
be due to affinity, to common descent; or it can be due to convergent evolution..
The differences between species can be due to lack of affinity, or they can be found
in closely related species. The student of survival value concentrates on the latter
differences, because they must be due to recent adaptive radiation.

(Tinbergen, 1964).
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Tinbergen’s characterization of comparative biology foreshadowed the basic
concepts of modern phylogenetic comparative methods.

Curiously, from this high point in the evolutionary analyses of behavior, phylog-
eny was increasingly ignored by students of animal behavior, and by the 1970s, most
biologists believed that morphological characteristics were much more valuable for
comparative analyses than behavioral characteristics (Brooks & McLennan, 1991;
Harvey & Pagel, 1991). With the rise of the “new” comparative biology, behavior
has once again been thrust into the evolutionary spotlight (Owens, 2006).

Building and interpreting phylogenetic trees
Comparative studies attempt to identify evolutionary patterns by examining traits of
different extant (i.e., currently living) organisms. The traits can be molecular,
morphological, or behavioral characteristics. All modern comparative methods cen-
ter on building and interpreting “trees,” or phylogenies, which represent the pattern
of shared ancestry among organisms. In other words, phylogenies are like family
trees, except that instead of showing the ancestry of individuals in a family, they
are “evolutionary genealogies” (Rubenstein & Alcock, 2018). The term tree de-
scribes the physical appearance of these proposed phylogenetic relationships, which
are depicted as branching patterns of evolutionary events. An example of such a tree
(or phylogeny) is shown in Fig. 7.1. Fig. 7.1 shows seven hypothetical organisms
(AeG) and their phylogenetic relationships. These organisms could represent
different species, subspecies, genera, or any other taxonomic group, so in the lan-
guage of comparative biology, we refer to them as different taxa, with each referred

FIGURE 7.1

A phylogenetic tree for seven hypothetical taxa, labeled AeG.
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to individually as a taxon. Extant taxa occur at the tips of branches, while all other
parts of the tree represent evolutionary ancestors.

What can we infer from this tree? Well, for one thing, the tree shows us that taxon
A and taxon B are each other’s closest evolutionary relatives (comparative biologists
call them sister taxa) because they both diverge from the same node (the point at
which the branches leading to A and B emerge). Taxa C and D are likewise sister
taxa, whereas taxon E is more distantly but equally related to both C and D. Together
these taxa form a clade (a group of taxa sharing a common ancestor, with closer
relationships to each other than to members of any other group). In tree terminology,
a clade comprises all the branch tips that come from the same node. In Fig. 7.1,
A and B are considered a clade, as are C-D, C-D-E, A-B-C-D-E, A-B-C-D-E-F,
and A-B-C-D-E-F-G. A clade can also be called a monophyletic group (the terms
are synonymous), which refers to a group of taxa descended from a single ancestral
taxon and including the ancestral species and all descendant species. Note that the
common ancestor is included in a clade (or monophyletic group). In tree terminol-
ogy, taxonomic groups can include ancestors as well as extant taxa. Two other terms
that are important in discussing trees are the root (base) of the tree and the inter-
nodes (branches between nodes).

How do we determine relationships among taxa to build a phylogenetic tree?
These analyses are based primarily on a careful examination of characters across
taxa. A phylogenetic character includes a set of possible states or conditions that
are thought to evolve from one to the other, with each alternative condition called
a character state or trait. We group organisms together based on shared derived
traits, which are novel character states that are shared by two or more taxa because
they were inherited from a common ancestor in which the trait originated. For
example, in songbirds, we can divide the species into those that build open-cup nests
and those that build domed nests with roofs (Price & Griffith, 2017). Suppose that
open-cup nest building behavior evolved in an ancient species of bird (indicated
by X on the tree shown in Fig. 7.2) and that the ancestors of that species built domed
nests. Domed nests were thus the ancestral state and cup nests the relatively derived
trait (note that it is also possible for domed nest building behavior to reappear
through the loss of the derived trait). This transition from domed to cup nests could
have happened anywhere along the internode indicated by X (even though the whole
internode is coded as cup nest building in Fig. 7.2). Suppose further that two species,
A and B, evolved from that cup nest building ancestor. If species A and B also build
cup nests, and if they inherited this behavior from their common ancestor, then cup
nest building is a shared derived trait in species A and B and is said to be homolo-
gous (it was inherited by both species from a common ancestor). The goal of modern
taxonomy (called “phylogenetic systematics”) is to organize taxa into clades based
on homologous, shared derived traits.

Of course, there are many ways to sort the taxa in Fig. 7.2 into groups that are not
monophyletic (not clades) and thus do not reflect evolutionary relationships. For
example, a taxonomic group including species A-B-C, based on the presence of
cup nests, would be called a polyphyletic group because the trait the group is based
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on (cup nest building) is shared due to the independent evolution of this trait on
branches X and Y rather than common ancestry. Cup nest building behavior in this
case is said to be a homoplasy (it was not inherited from a common ancestor). Poly-
phyletic groups are based on homoplasies and do not include a common ancestor.
Alternatively, a group including just D-E-F-G, based on having domed nests, would
be called a paraphyletic group because it includes the common ancestor but not all
the descendants of that ancestor. Paraphyletic groups are based on homologous,
shared ancestral traits rather than on shared derived traits. The easiest way to distin-
guish polyphyletic and paraphyletic groups is by whether or not they include the
group’s most recent common ancestor. Both groupings include taxa that are more
closely related to nongroup members than to other group members (e.g., D is
more closely related to C than to its other group members, and vice versa).

Many well-known animal groups are not monophyletic. Pandas, for example,
provide a good example of a polyphyletic group. Despite some striking similarities
(including an extra “pseudo thumb” for eating bamboo), giant pandas (Ailuropoda
melanoleuca) and red pandas (Ailurus fulgens) are actually distantly related and
did not inherit these traits from a common panda ancestor. Their shared traits are
homoplasies that were derived independently through convergent evolution. Rep-
tiles provide a good example of a paraphyletic group because the common ancestor

FIGURE 7.2

A phylogeny showing the same relationships as Fig. 7.1, but with two character states
mapped onto the tree: open-cup nest building (indicated by black) and domed nest
building (indicated by white). Cup nest building presumably evolved from domed nest
building twice on this tree, along branches X and Y. If cup nest building evolved earlier on
branch Z, two more transitions back to dome building would have had to occur on the
branches leading to taxa D and E, which would be a less parsimonious explanation of
evolutionary history.
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was a reptile but some descendants of that ancestor, such as birds, are not considered
reptiles. Reptiles are grouped together based on shared character states that are rela-
tively ancestral in comparison to those of birds (e.g., scales vs. feathers). As a result,
interestingly, some reptiles, such as crocodiles, are actually more closely related to
birds than to other reptiles.

Although behavioral characters have been used to construct phylogenies, these
days, trees are constructed primarily using molecular data, such as DNA sequences.
This is not necessarily because DNA nucleotide characters exhibit less homoplasy
than do behavioral characters but because DNA provides so many charactersd
thousands or even billions rather than dozens. Phylogenies are now being con-
structed based on entire genomes. The phylogenetic trees produced from such mo-
lecular analyses have been extremely useful in animal behavior studies in recent
decades because they provide an independent and relatively reliable way of esti-
mating phylogenetic relationships. Using them, we can infer the sequence of events
through which behavior evolved.

Using phylogenies to reconstruct the evolution of behaviors
Rather than using traits to build a phylogeny, in this exercise, we will use indepen-
dently generated phylogenetic trees to reconstruct the evolution of behavioral traits.
How do we use trees to reconstruct behavioral evolution? Parsimony (simple expla-
nations are better than complicated ones) is the most commonly used criterion in
both building phylogenetic trees and in using these trees to trace past evolutionary
changes in a character. In practice, the parsimony criterion means trying to minimize
the number of character-state changes (state transitions) needed to explain the cur-
rent distribution of character states among extant taxa. For example, let us return to
Fig. 7.2. Theoretically, cup nest building behavior could have evolved earlier on in
the tree, just once in ancestor Z rather than twice in ancestors X and Y. However,
given the current distribution of cup and domed nest building taxa today, this would
mean that cup nests were lost at least twice in taxa D and E. This alternative scenario
would therefore involve three evolutionary changes, one gain and two losses of cup
nests, rather than just two gains, so we would say that it is a less parsimonious
explanation.

We can use this same parsimony criterion to determine which character states are
relatively ancestral and which are derived; that is, we can determine the order
(evolutionary sequence) of character state changes. If cup nests were ancestral to
domed nests, for example, our phylogeny suggests that at least four evolutionary
changes would have to have occurred, such as domed nests evolving from cup nests
four times independently in taxa D, E, F, and G. Can you come up with some other
possible evolutionary scenarios that would have resulted in the distribution of cup
nest building and domed nest building taxa today? Any way you look at it, using
these character states on this phylogeny, it is more parsimonious to assume that
domed nest building was the ancestral behavior in songbirds.
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Sometimes there are multiple possible evolutionary scenarios that are equally
parsimonious. For example, imagine if taxon G were the only domed nest building
taxon and all other taxa (AeF) built cup nests. The ancestor, at the root of the tree,
could have built cup nests or domed nests and either possibility would be equally
parsimonious. How dowe decide which scenario is more likely, and thus which char-
acter state is ancestral and which derived? In such cases, we can look to additional
taxa, called outgroups, that are closely related to, but are outside (i.e., not as closely
related to), the group of interest, which of course is called the ingroup. Including
outgroup taxa simply increases the size of our tree so that we can determine the
directionality of character state transitions. In cases that cannot be resolved using
outgroups, sometimes additional information about the characters can help us
decide. For example, character state transitions in one direction might be more prob-
able than changes in the other direction. In reconstructing the evolution of flight in
birds, for instance, the ability to fly seems far more likely to be lost than gained dur-
ing evolutionary history simply because it requires so many unique specializations.

When done carefully, comparative studies can help us to infer adaptation, or
whether the character of interest has evolved into its current state in response to nat-
ural selection. For example, building cheap, relatively disposable open-cup nests
could have been an adaptation in response to changes in predation, nest parasites,
or perhaps even levels of climatic variability. We would need to compare changes
in nest building to changes in other characters to see how well they match up. There
are a wide variety of methods for statistically comparing such character changes
across taxa, ranging from simple to highly complex. Here we will mostly focus
on reconstructing the evolution of individual characters.

Purpose
Our general research question in this exercise is: what was the evolutionary sequence
of events (i.e., the order of character state changes) that led to the behavioral char-
acteristics we see in a group of species today? To reconstruct these evolutionary
changes, you will need to define a set of characters and character states, map the
characters onto a phylogenetic tree, and use the principle of parsimony (minimizing
the number of character state transitions) to reconstruct when (on which internodes)
each character changed from one state to another.

Methods
This exercise can be done with any clade of related taxa. These can be different spe-
cies, different taxonomic families, or any other level of taxonomic group, as long as
you determine their relationships. Here we will use a group of six species from the
New World blackbird family (Icteridae). You can do this exercise with paper and
pencil or by using a dry-erase whiteboard and colored dry-erase pens, which you
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can use to draw the tree, the character states, and evolutionary events with different
characters color coded. Alternatively, you can use a free computer program called
Mesquite (Maddison & Maddison, 2019; available at http://mesquiteproject.org)
to visualize evolutionary changes. Directions for using Mesquite are in the
Appendix.

This activity consists of two parts. First, the whole class will work on recon-
structing the evolution of some behavioral characteristics using the provided phylog-
eny of blackbirds. Second, working with a partner or in a small group, you will
choose another set of taxa and use a phylogeny and the behaviors exhibited by
the taxa to reconstruct how those behaviors evolved.

Form working groups of two to four students. If you are going to use a computer
to do your analysis, your instructor will take some time to teach you how to use
Mesquite. If you are going to do the analyses by hand using paper or a whiteboard,
you can proceed directly to the exercises in the following.

Activity 1: Whole-class exercise
You will use the phylogeny in Fig. 7.3, which shows hypothesized evolutionary re-
lationships among six songbird species from the NewWorld blackbird family (Icter-
idae), including the red-winged blackbird (Agelaius phoeniceus) and its
evolutionary relatives. This tree is similar to the ones shown in Figs. 7.1 and 7.2
but is turned 90 degrees clockwise. Note that all six species are extant (currently
living) and that we are using this hypothesized phylogenetic tree to infer

FIGURE 7.3

A phylogenetic tree showing hypothesized evolutionary relationships among six species in
the New World blackbird family (Icteridae), based on molecular data (Powell et al., 2014).
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evolutionary history from their current character states. This particular phylogeny is
based on an extensive comparison of mitochondrial and nuclear DNA sequences
(Powell et al., 2014).

A number of studies have been published on the singing and breeding behavior of
these species. In fact, the red-winged blackbird is among the most well-studied song-
birds in the world (Searcy & Yasukawa, 1995). In some of these species, including
red-winged blackbirds, only males produce complex songs, whereas in other spe-
cies, both males and females produce similar songs at similar rates. In a few species,
males and females even coordinate their vocalizations to produce complex duets. In
some species, males and females mate as pairs (they are socially monogamous),
whereas in others, some males pair with multiple females (they are polygynous).
Some breed in the tropics and others breed in the temperate regions of North Amer-
ica. Some migrate annually, whereas others are sedentary and stay in the same areas
year-round.

From published studies (Odom et al., 2015; Price, 2009), we can assemble the
following descriptions of each species. You will use the following information
and Fig. 7.3 to infer the evolutionary history of singing, mating system, breeding
latitude, and migratory behavior in this group of animals.

A. Red-winged blackbird (A. phoeniceus)
Males defend territories using complex vocal displays (song). Females produce a
variety of sounds, some of which are as complex as the songs of males, but they
do not sing like males. The mating system is polygyny, with some males pairing
with multiple females and other males not pairing at all. Most populations breed
in the temperate areas of North America and migrate annually.

B. Red-shouldered blackbird (Agelaius assimilis)
Both males and females defend their shared territory using songs, often by
combining their vocalizations into a duet. Males and females are monogamous.
They breed in the tropics and do not migrate (they are sedentary).

C. Tricolored blackbird (Agelaius tricolor)
Males sing and females do not sing. Mating is polygynous. The species breeds in
temperate regions and migrates annually.

D. Tawny-shouldered blackbird (Agelaius humeralis)
Both males and females sing, often by combining their vocalizations into
complex duets. Mating is monogamous. They breed in the tropics and are
sedentary.

E. Yellow-shouldered blackbird (Agelaius xanthomus)
Both sexes sing, but males and females do not coordinate their vocalizations as
duets. The species is monogamous, tropical, and sedentary.

F. Jamaican blackbird (Nesopsar nigerrimus)
Both sexes sing, but without producing duets. The species is also monogamous,
tropical, and sedentary.

How can we make sense of the diversity of the behavioral and life-history char-
acteristics among these six species? What are the character states, and which ones
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are ancestral and which ones are derived? What is the evolutionary sequence of
events that produced the current distribution of characteristics we see today?

Defining character states
The first and, at this point, most important step in your analysis is to identify the
behavioral characters of interest and their possible states. The simplest characters
are those with only two possible states (the so-called binary characters). Discuss
within your group the characters and their states. For example, singing could be
scored as a multistate character with three states (only males sing, both sexes
sing, and both sexes duet). Note, however, that one of our goals in scoring phyloge-
netic characters is to define character states that are mutually exclusive, either one
thing or another. Are “both sexes sing” and “both sexes duet” mutually exclusive
character states, given that females must sing in order to combine their songs
with male songs? We therefore recommend that singing be scored as two separate
binary characters (presence/absence of female song and presence/absence of duet-
ting). Your group will decide which characters to use, and you will assign two
possible states for each of them. Once your group has agreed on characters and
states, compare them to those of another group. It is possible that the two groups
will not agree. See if you can find a common system of characters and states.

For the purposes of this exercise, the authors have defined five binary characters,
but your class could choose to use a different set. Use the information on each of the
six species to fill in the appropriate spaces in Table 7.1, which lists the authors’ five
binary characters. For some characters the possible states could be “absent” and

Table 7.1 Five behavioral characters for six species of blackbirds, with
states not filled in.

Species

Characters

Female
song

Vocal
duets

Mating
system

Breeding
latitude

Migratory
behavior

Red-winged
blackbird

Red-shouldered
blackbird

Tricolored
blackbird

Tawny-shouldered
blackbird

Yellow-shouldered
blackbird

Jamaican
blackbird
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“present” (or 0 and 1 in Mesquite), whereas for others the possible states could be
more descriptive, such as “monogamous” and “polygynous” (likewise scored as
0 and 1 in Mesquite).

Mapping characters onto the tree
Use the information from Table 7.1 and the hypothesized phylogeny of Fig. 7.3 to
“map” the five behavioral characters onto the branches of the phylogeny. For each
character in turn, using either paper/whiteboard methods or Mesquite, use the cur-
rent character states of these species to figure out which state is ancestral and where
(on which internode or internodes) the derived state evolved. See if you can find the
simplest, most parsimonious evolutionary scenario for each character.

Note that it is possible to find multiple evolutionary histories for a character that
involve the same minimum number of changes. In the ancestors of red-winged black-
birds, red-shouldered blackbirds, and tricolored blackbirds, for example, you may find
that character state changes could have occurred twice independently in red-winged
blackbirds and tricolored blackbirds or once in the common ancestor of these three spe-
cies and then again (in the opposite direction) in red-shouldered blackbirds. Both pos-
sibilities involve the same number of evolutionary transitions and so are equally
parsimonious. How dowe decide which scenario is more likely? As mentioned earlier,
sometimes looking at additional information can be helpful. For instance, biogeo-
graphic evidence (based on geographic distributions) and genetic data suggest that
red-shouldered blackbirds moved to the tropics relatively recently from a temperate
breeding ancestor (Barker et al., 2008). Thus it seems likely that temperate breeding
was gained earlier on in our tree and then lost in red-shouldered blackbirds rather
than gained twice independently in red-winged blackbirds and tricolored blackbirds.
Does this help us to resolve changes in other characters, such as migration?

Results/discussion
Once your group has completed its phylogeny, discuss the following questions. How
did you resolve characters that have more than one possible most parsimonious
evolutionary history? Do any character state changes seem correlated with each
other (tending to occur together), and do any characters seem likely to influence
each other? Once your group has discussed these and any other questions that occur
to you, present your phylogeny of blackbird evolution and discuss it with the rest of
the class. It is possible that your group’s mapping of behavioral character state tran-
sitions will differ from that of another group. Be prepared to defend your proposed
evolutionary sequence and to question the sequences of other groups. By what cri-
terion can the class decide which proposed sequence of behavioral state transitions is
“best”? It may interest you to know that disagreements in phylogenetics (this kind of
analysis) can and do become extremely heated, both in print and in person.
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Questions for in-class discussion
If time permits discuss the following questions within your group and then with the
whole class. Alternatively, if time is short, each group could be assigned to discuss
one question and present its conclusions to the rest of the class.

1. According to some comparative biologists, you should never use the information
you want to study to build your phylogenetic tree.Why is it important to follow
this rule? What happens if you do use the information you want to study to build
your phylogenetic tree?

2. Originally, ethologists saw behavior as another set of characters that could be
used to construct phylogenies, along with morphological information. These
days, however, phylogenies are usually constructed from molecular data.
Should we use behavioral data when constructing phylogenies? Why or why
not? Which source of information is better? Why?

3. Why is the parsimony criterion used in reconstructing the evolution of character
traits? Do you think evolution always necessarily operates according to this
principle? Explain.

4. Comparative methods can be used to test whether different characters are
correlated with each other across species, such as whether female singing is
correlated with monogamy. In making such comparisons, should we always
treat each species as an independent “statistical sample” so that, say, five species
exhibiting an apparent correlation between female song and monogamy provide
more statistical support than just three species sharing these traits? What if these
character states are homologous across species, having evolved just once in a
common ancestor rather than evolving independently as a result of selection due
to similar environments? Does this make a difference?

5. Songbird species that build cup-shaped nests are much more common globally
than species that build domed nests, despite the fact that cup nests evolved more
recently on the songbird phylogeny (Price & Griffith, 2017). Moreover, most
cup-shaped nests are simpler in construction than domed nests. What do these
patterns tell us about how the rarity and the complexity of traits relate to the
directionality of evolution?

6. In most temperate breeding songbird species, males produce complex songs
and females vocalize but do not “sing” like males. Countless studies have
investigated why male songbirds sing. Yet, recent phylogenetic studies show
that sex differences in singing behavior have generally evolved by females
losing song rather than males gaining it (Odom et al., 2014). Likewise,
although we often ask why birds fly south in the winter, phylogenetic evidence
shows that the ancestors of some migratory songbirds were tropical rather than
temperate (e.g., Outlaw et al., 2003; Price, 2009), suggesting that migration
evolved as a way to breed in northern regions rather than as a way to winter in
southern regions. Do these new findings indicate that previous ideas were
wrong?
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Activity 2: Small-group projects
Now that you have had some practice, your group can attempt a second analysis with
a somewhat more complex example. Our general research question, however, re-
mains the same: what was the evolutionary sequence of events for the behavior or
behaviors of interest? You will once again have to define behavioral character states
and map character state transitions onto a phylogeny to infer the ancestral states and
when each derived state evolved.

Your instructor will provide several data sets for analysis or will tell you how to
find appropriate phylogenies and behavioral descriptions. Choose one set and have
at it! Devise a table to record the states of the behavioral characters for each taxon.
Follow the steps from the whole-class exercise (using either paper/whiteboard
methods or Mesquite) to map the behavioral states onto the proposed phylogeny
and then to infer the evolutionary history of the behavioral characters of interest.
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Part II. Instructor notes

Classroom management/blocks of analysis
This exercise can be done in two sections. The whole-class exercise can be
completed in a single lab period of 2e3 h, with the small-group projects being
done next, outside the lab time. For the whole-class exercise, allow about 30 min
for students to define the character states and discuss them. If you plan to use
Mesquite (see Appendix), then plan to spend about 30 min showing the program
to students by using an example data file to walk them through the various functions
and to give them some time to “play” with the program on their own. Once they un-
derstand how Mesquite works give them 30e60 min to build their character matrix,
construct the tree, trace character histories, and discuss their results. Make sure you
leave enough time for each group to explain their character state reconstructions to
the rest of the class or lab.

Students can do their small-group projects outside the lab or classtime, but they
should plan to leave some time at the end of the lab period to answer questions they
have about the project. Most students are not familiar with “tree thinking,” so the
time spent introducing and reinforcing concepts and methods to them is extremely
important.

Groups of three to four students work best, although pairs of students can also
produce very good work. In some cases, four students may be too many, especially
if one student is reticent. In other cases, four students are too few because none of
them take to “tree thinking.” Careful monitoring during the whole-class exercise and
asking for progress reports during the small-group projects will help ensure that each
group is making progress.

Teaching the activity
Preclass preparation and potential variations
This exercise could be done by hand with paper and pencils or better yet by giving
each group a dry-erase whiteboard and several colors of dry-erase pens. Cheap white
laminate wall covering can be purchased in 4 ! 8-foot sheets and cut into 2 ! 4-foot
boards to be given to each group.

Hand methods will be sufficient for simple trees and characters, such as in the
whole-class exercise, but may prove to be more difficult for more complex trees
and sets of characters, as would be encountered in the small-group projects. Some
students may feel more comfortable using a computer, whereas others might be
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bewildered by all of Mesquite’s various functions (in the Appendix, we describe
only a very small fraction of the program’s features). Decide in advance whether
you want to do the exercise by hand, on computers, or as some combination of
the two. You may also choose to map other characters onto the blackbird phylogeny,
such as plumage colors. If you decide to have the students use Mesquite, you should
plan to spend a few hours beforehand learning its ins and outs so you can answer
their questions (they will have many).

The small-group projects can be based on trees that are provided by the
instructor, or students can be asked to find trees in the published literature or other
sources. Some excellent websites for generating evolutionary phylogenies are Time-
Tree (http://timetree.org) and the Tree of Life Web Project (http://tolweb.org/tree/).
Student groups could build their phylogenies based on those relationships for a
wide variety of taxonomic groups, although birds may be your best bet given the
many phylogenetic and behavioral studies that have been published.

In-class preparation
Once students define their character states (as in Table 7.2), they can map their
behavioral characters onto the tree shown in Fig. 7.3 by hand using paper/white-
boards or on a computer using Mesquite. If they do this by hand, first have the stu-
dents record the character states of each of the five behavioral characters near the
tips of the tree. It is easiest to have them record each character on a separate line,
and perhaps using a different color, so they will need five lines for each species
(one for female song, one for duetting, etc.). Once the character states are recorded
at the tips, the students can focus on each character in turn to try to figure out which

Table 7.2 States of five behavioral characters for six species of blackbirds.

Species

Characters

Female
song

Vocal
duets

Mating
system

Breeding
latitude

Migratory
behavior

Red-winged
blackbird

0 0 1 1 1

Red-shouldered
blackbird

1 1 0 0 0

Tricolored
blackbird

0 0 1 1 1

Tawny-shouldered
blackbird

1 1 0 0 0

Yellow-shouldered
blackbird

1 0 0 0 0

Jamaican
blackbird

1 0 0 0 0
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is the ancestral state and where (on what branch or internode) each derived state
evolved. Typically, these evolutionary events are depicted by drawing a short line
across the branch or internode and writing the name of the derived state next to it.
Good examples are presented in Brooks and McLennan (1991) and Rubenstein
and Alcock (2018).

Areas of potential confusion or difficulty for students
Whether they map behavior by hand or with Mesquite, your students should begin to
think about the evolution of behavior in a very different way. Tree thinking will be
new for most students, so at each step, it would be a good idea to spend some time
talking about what they did, what they found, and what it means.

For both the whole-class exercise and small-group projects, students may have
trouble scoring characters into clearly defined character states. In the whole-class ex-
ercise, for example, some may want to lump female song and duets into a single
multistate character. Emphasize that character states should be mutually exclusive
and that using lots of simple binary character states is usually much easier to inter-
pret than using fewer, more complicated characters.

Students might also have trouble when there is more than one possible most
parsimonious evolutionary history for a character (as in the ancestors of red-
winged blackbirds, red-shouldered blackbirds, and tricolored blackbirds). A trait
may have been gained twice independently or gained once and lost once; both pos-
sibilities involve the same number of evolutionary transitions. Such issues are com-
mon in evolutionary reconstructions. Talk about how we might try to resolve such
uncertainties.

In the small-group projects, you may want to discourage students from choosing
very complex trees (in excess of 30 taxa) or poorly resolved trees with many polyt-
omies (unresolved relationships in which more than two branches come from a sin-
gle node). For example, you could suggest that they use trees with fewer than 15 taxa
or you could provide trees for them to use. If they use Mesquite, the most difficult
step your students will face is converting a default random tree into the tree that they
have chosen to analyze (see Appendix). Moving branches around in Mesquite is
easy, but if students do it without thinking about what they are doing, the result
will be a very messy tree and a lot of wasted time. Also, students may not realize
at first that trees showing the same relationships can look different. For example,
selecting sister taxa and rotating their branches at the node will change the positions
of the species but will not change their relationships at all. A quick demonstration on
a chalkboard/whiteboard would help show this to your students.

Whatever your students choose to do for their small-group projects, once they
find a system to analyze, they will need to do the same three steps as in the
whole-class exercise: (1) obtain a tree showing relationships among the taxa of in-
terest, (2) define behavioral character states and enter these data into a table or into
Mesquite, and (3) map (trace) the behavioral character transitions on the tree.
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Another potential modification to the activity
Early comparative studies of behavior often used behavioral characters to construct
trees. There is really no reason why we could not do that as part of this exercise,
especially given the tools at our disposal. Students could use Mesquite to construct
one tree using a set of behavioral characters (i.e., they could use shared derived char-
acter states to define relationships, using only behavioral characters) and then
compare that tree to another one constructed from other characters (e.g., molecular
sequences or morphological character states). In some cases the behavioral trees
could be used to resolve polytomies, or vice versa.

Answers to the questions for in-class discussion
1. The idea that one should never use the information you want to study to build

your phylogenetic tree is an attempt to avoid circular reasoning. If, for example,
you constructed a phylogeny using behavioral characters and then used that
phylogeny to reconstruct the evolutionary sequence of events for those same
characters, it is pretty obvious that you would not have an independent
assessment of evolutionary history. “Phylogenetic systematics” (the field of
biology focused on determining evolutionary relationships among organisms)
seeks to construct phylogenies that are independent of assumptions about
phylogenetic history, so systematists usually construct trees based on molecular
data such as DNA sequences. A molecular phylogeny provides an independent
hypothesis for phylogenetic relationships among taxa, which can then be used
to provide information about the evolution of the behavioral characters.

2. Are behavioral characters useful in constructing phylogenies? For any character,
the critical distinction made by comparative biologists is between homologies,
which can indicate phylogenetic relationships, and homoplasies, which can be
misleading about phylogeny (Brooks & McLennan, 1991). Two species can
share a derived behavioral state by homology just as they could share a
morphological state or a DNA nucleotide sequence by homology. Although it is
perhaps less common these days to use behavioral characters to construct trees,
there is no a priori reason to assume that they are less valid than other char-
acters. Some biologists assume that behavioral characters tend to be highly
variable and are subject to modification by experience. Yet morphological
features are also subject to environmental influences, and DNA sequences can
be extremely variable across taxa with high levels of homoplasy. Molecular
sequences are so frequently used in building trees because they provide so many
characters, not necessarily because each character (i.e., each nucleotide) is
necessarily more informative than other types of characters.

3. Parsimony is a working assumption used by systematists. Theoretically, when
building a phylogenetic tree, if we did not limit the number of times each
character transitioned between states, we could generate huge numbers of po-
tential trees from the same set of data. How would we decide which tree reflects
the actual pattern of relationships among taxa? Clearly, we need some kind of
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rule by which we can choose a tree (remembering that any tree is a hypothesis
for the true phylogeny). Choosing the most parsimonious tree, the one with the
fewest possible character changes, is simply a rule we can follow to select
among all the possibilities. However, the most parsimonious tree may not
necessarily be the correct tree. Evolution can proceed randomly or in response
to complex and changing environmental conditions, so evolution may not
necessarily operate according to the principle of parsimony.

4. When testing whether different characters are correlated with each other across
taxa, should each species be considered as an independent sample, even if
shared character states among these species are due to shared ancestry (ho-
mology) and thus are not really independent? Modern comparative methods use
phylogenies to overcome this inherent difficulty, and they have provided lots of
valuable information for biologists interested in the evolutionary history of
behavior. Taking phylogenetic relationships into account allows us to make
comparisons among taxa that are statistically independent. In other words, if
three blackbird species exhibit both female song and monogamy because both
traits evolved in a common ancestor, we should not consider them as three
independent examples showing a statistical correlation between these traits.
Each of these traits may have evolved just once in the past, perhaps together but
perhaps not. In contrast, if our analysis showed that female song was lost or
gained every time the species transitioned between monogamy and other mating
systems, then that would provide good evidence for an evolutionary correlation.
Understanding phylogeny allows us to see if traits truly have evolved together.

5. Interestingly, although cup-shaped nests evolved more recently than domed nests,
most of the world’s songbirds (approximately 75%) build cup-shaped nests
(Price&Griffith, 2017). Cup nests are also generally simpler to construct. These
observations illustrate two important points. First, although biologists have
often assumed that the ancestral bird nest was cup shaped, mostly because this
design is so widespread, there is no reason to assume that the current prevalence
of a trait indicates the order of events in the evolutionary past. Second, evolution
does not always proceed from simple to complex. Indeed, there are many ex-
amples (including the evolution of female song) in which complex behavioral
patterns have become lost or simplified during evolutionary history.

6. Many biologists, including Charles Darwin himself, have explained the complex
singing behaviors of male songbirds as having evolved through the influence of
sexual selection for elaborate male traits. Recent findings, however, show that
singing by both sexes was the ancestral state in songbirds and that female song
has been lost repeatedly across the songbird phylogeny (Odom et al., 2014).
Thus it might be more appropriate to ask why so many females do not produce
complex songs, rather than just focusing on why males do. In a similar way,
phylogenetic evidence that temperate migratory species evolved from tropical,
nonmigratory ancestors suggests that we should be asking why birds migrate
north to breed, in addition to asking why they migrate south in the winter. These
new findings from phylogenetic studies do not necessarily mean that old evi-
dence is wrong. Rather, they bring up new questions and suggest new ways of
thinking about the evolution of animal behavior.
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Appendix: Using Mesquite
Mesquite (available at http://www.mesquiteproject.org) is a free computer program
that can help students to visualize evolutionary sequences by mapping evolutionary
events (changes in character state) onto phylogenetic trees. The following directions
are for Mesquite version 3.61 (Maddison & Maddison, 2019).

Open Mesquite and select File > New. Provide a name for the file (e.g., “Black-
bird evolution”) and a location where it will be saved. When you click OK, a New
File Options window will appear. The Make Taxa Block should be checked (check it
if it is not checked), enter the number of taxa (6 in our example), check Make Char-
acter Matrix, and hit OK. In the New Character Matrix window enter the number of
characters (5 in our example). There are several options in the Type of Data menu;
for this exercise select Standard Categorical Data. Click OK.

A Project Window will open showing an empty Character Matrix (Fig. 7.4). Here
you can enter the names of taxa, characters, and character states. There are several
tools along the left side that allow you to manipulate the matrix. When you hold the
cursor over each of the buttons, a description of what it does appears at the bottom of
the window.

Click on the Edit tool and use it to enter each taxon name along the left column
and character name along the top as shown earlier in Table 7.1. Then enter your

FIGURE 7.4

Project window with empty character matrix.
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previously defined binary character states in each cell as either a 0 or 1, as in Fig. 7.5.
For example, you could score species without female song as 0 and with female song
as 1, and you could score monogamous species as 0 and polygynous species as 1. In
this simple example, we have only five characters with just two states each, but in
other cases, there could be more characters, which could have two or more discrete
states. Alternatively, our characters could be continuous rather than discrete or could
be nucleotides rather than behavioral categories. Each has a specific option in the
Type of Data menu (see earlier discussion).

A matrix filled with 0s and 1s is often not the easiest thing to interpret; we would
be better served if the character states were more descriptive. You can name the char-
acter states as follows. At the bottom left are five small buttons next to a small blue
“i”; each looks like a little window. Select the one that is second from the right, the
Show State Names Editor Window (this is also available in a drop-down menu as
Matrix > Edit State Names). Select the Edit tool and use it to give names to our char-
acters and their states (Fig. 7.6). Now go back to the Character Matrix by clicking
the tab at the top of the window. As you can see, all the 0s and 1s have been replaced
with character state names. One thing to note is that when adding or editing char-
acter states in the matrix you still need to type a 0 or 1, even if the states now
have more descriptive names.

FIGURE 7.5

Character matrix with taxa, characters, and states entered.
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Creating and editing trees
There are ways to import previously constructed phylogenies into Mesquite, but this
is a little beyond the scope of our exercise. Here we will manually recreate the tree
shown in Fig. 7.3. Select Taxa & Trees > New Tree Window >With Tree To Edit
By Hand. A window tab will appear with a randomly organized tree of our six
taxa (Fig. 7.7), which we will need to modify to match the relationships in
Fig. 7.3. Click on the Select tool (the arrow) and use it to click on the various
branches and drag them over to connect with others. We suggest starting with pairs
of sister species (e.g., red-winged blackbird and red-shouldered blackbird). Note that
for sister taxa, it does not matter which one is to the right and which one is to the
leftdthey just have to branch from the same node. The order in which you click
and drag determines left and right positioning, so if you want a topology that is iden-
tical to that shown in Fig. 7.3, you may need to use Edit > Undo a few times (or the
Interchange branches tool) to get the particular branching pattern you want. By
default, Mesquite will draw a Square Tree, but you can change it to a different
form using Display > Tree Form. You can rotate the tree using Display -
> Orientation. You can also change other aspects of the tree, such as the thickness
of the lines (Display > Line Width) and the angle of the taxon names (Dis-
play > Names > Taxon Name Angle). When you are happy with how your tree
looks save it using Tree > Store Tree in Tree Block As ..

FIGURE 7.6

Entering names for each character state.
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Discrete character state reconstruction using parsimony
With the Tree Window open select Analysis:Tree > Trace Character History. Select
Parsimony Ancestral States and hit OK. Ancestral states for our characters will
appear on the branches (Fig. 7.8), similar to how they were shown in Fig. 7.2.
You can look at the reconstructions of each character by clicking on the arrows in
the Trace Character box (which is usually at the bottom left of your Tree Window).
In Mesquite, branches are shown with the colors of all the possible states that they
could have under parsimony. Thus if there are two most parsimonious scenarios on a
branch, it will be shown as unresolved with both character state colors (e.g., white
and black). When you move the cursor over a branch, you will see the character state
or states at the bottom of the Trace Character box. You may have to move this box up
to see its bottom, or so it does not obscure parts of your tree.

Now we are ready to interpret the evolution of our characters on the blackbird
phylogeny. For each character, which state is ancestral and which is more recently
derived? Do any character state changes seem correlated with each other, and do
any characters seem likely to influence each other? Do any characters exhibit mul-
tiple possible evolutionary scenarios that are equally parsimonious? How will we

FIGURE 7.7

Default tree before moving branches.
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resolve these? Note that the tree itself is a hypothesized phylogeny, so these evolu-
tionary changes are also hypotheses.

If you change a character state in your matrix, the results will automatically
appear in your tree (i.e., the tree is “hot linked” to the character matrix). Go to
the Character Matrix window and change the character state of the character you
are currently tracing in your tree window for one of the taxa. The character state
will automatically change in the tree window. This is a general feature of Mesquite;
whenever you change something in one window, it will affect what is happening in
all the windows that are related to it.

The abovementioned description of Mesquite covers only a small fraction of the
functions it offers for evolutionary studies. The best way to learn Mesquite is to play
with it. Students may also want to spend some time going through the Mesquite
manual at http://www.mesquiteproject.org/.

FIGURE 7.8

Ancestral states for female song reconstructed on the blackbird phylogeny.
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